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AKVIS CHAMELEON 12.0 | COLAGENS E MONTAGENS DE FOTOS

AKVIS Chameleon é um programa para criação de colagens ou de montagens de fotos.

Precedentemente, tinha que selecionar-se com muito cuidado um objecto para a montagem de fotos antes de inserir o
resultado num novo fundo. Com o programa AKVIS Chameleon, não é preciso fazer esta parte penosa do trabalho e pode
concentrar-se na parte criadora.

Existem muitas maneiras de AKVIS Chameleon. Você pode criar  cartões postais personalizados para seus entes queridos;
fazer o álbum de casamento usando todos os tipos de fotos e fundos; corrigir os olhos fechados (implantando os olhos
abertos de outra foto da série) ou mudar a aparência de uma pessoa, etc.
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O Chameleon pode ser usado para web design personalizado, cartões de felicitação,  materiais promocionais, logos e
wallpapers. Você pode  combinar imagens сom cores inteiramente diferentes para criar o efeito do  desenho sobre uma
superfície texturizada (papel amassado, madeira, etc), - e tudo isso com apenas um clique do mouse.

Transforme as imagens simples no algo atraente com AKVIS Chameleon!
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O programa propõe 4 modos de criação de montagens de fotos:

Montagem. Neste modo, o programa combina as imagens para criar uma foto-montagem realista. Os objectos são
transferidos para um novo fundo e as zonas inuteis do fragmento inserido desaparecem. Basta marcar com o lapis azul
as zonas que devem permanecer na colagem, e com o lapis vermelho as que devem desaparecer. O programa reconhece
os limites do objecto e cria uma foto-colagem realista.

Camaleão. Neste modo, o programa ajusta o objecto inserido à gama de cores da imagem alvo e alisa os contornos do
objecto, exactamente como fazem os camaleões.

Fusão. Neste modo o programa alisa as bordas do objeto inserido e as ajusta às variações de cores da imagem de
fundo e também faz com que o objeto fique semi-transparente de modo que a textura da imagem de fundo pode ser
vista através do objeto.

Emersão. No modo Emersão, assim como no modo Montagem, o programa combina imagens para criar uma
fotomontagem na qual as imagens não sejam mescladas. A diferença entre esses dois modos é que no modo Emersão o
objeto (fragmento) inserido não se sobrepõe integralmente à imagem de fundo, mas fica encravada na imagem de fundo
de forma que apenas algumas partes da imagem objeto (fragmento) ficam visíveis. Este modo permite fotomontagens
com objetos difíceis como árvores, etc.

Dupla exposição (Home Deluxe/Business). Este modo é baseado na técnica usada pelos fotógrafos. As duas imagens
são sobrepostas numa única foto com o uso de diferentes modos de mesclagem e levando em conta os valores de
luminância. O mais popular é combinar cenas de paisagens com retratos humanos em que uma silhueta escurece uma
foto de sobreposição ou aparece isolada num fundo em branco com uma imagem de superposição mostrando através
dela.

 

Cinco modos de criação da colagens no Chameleon do AKVIS: Montagem — Camaleão — Fusão — Emersão — Dupla exposição:
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AKVIS Chameleon está disponível na duas versões – como versão autônoma e como plugin.

A versão do plugin é compatível com AliveColors, Adobe Photoshop, Photoshop Elements, Corel PaintShop Pro, etc. Leia mais
na página Compatibilidade do plugins.
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INSTALAÇÃO

Para instalar o programa (por exemplo AKVIS Chameleon) en Windows realiza as ações seguintes:

Execute o arquivo exe.
Selecione o idioma e clique no botão Instalar para iniciar o processo de instalação.

Leia o Acordo da licença. Ative a caixa de seleção "Aceito os termos do Contrato de Licença" e clique no botão
Seguinte.

Para instalar a versão do plugin selecione o editor (ou editores) de imagens na lista.

Para instalar a versão independente do Chameleon active a caixa de diálogo Standalone.

Para criar um atalho para o programa no desktop ative o componente Criar atalho em Área de trabalho.

Pressione o botão Seguinte.

Pressione o botão Instalar.
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A instalação começa.

O processo de instalação é terminado.

Você pode subscrever-se a Boletim de notícias de AKVIS para ser informado sobre atualizações, eventos e ofertas
especiais. Digite seu endereço de e-mail e confirme que você aceita a Política de Privacidade.
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Cliquar o botão Concluir para saida do programa da instalação.

Depois de instalação do plugin AKVIS Chameleon, vai ver em menu dos Filtros/Efeitos de editor uma nova fôlha AKVIS -
Chameleon. Por exemplo em Photoshop: Filtros -> AKVIS –> Chameleon. Use este comando para iniciar o plugin no editor.
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INSTALAÇÃO

Para instalar o programa (por exemplo AKVIS Chameleon) realiza as ações seguintes:

Abra o disco virtual dmg:

- akvis-chameleon-app.dmg para instalar a versão Standalone (independiente)

- akvis-chameleon-plugin.dmg para instalar o Plugin em editores de imagem.

Verá um texto de acordo, chamado Acordo da licença.

Em caso de consentimento com Acordo da licença clique no botão Aceitar.

Então, uma janela com a aplicação de AKVIS Chameleon ou com a pasta de AKVIS Chameleon Plugin abrir-se-á.

 

Para instalar a versão standalone arraste a aplicação AKVIS Chameleon na pasta Aplicações.

Para instalar a versão plugin arraste a pasta de AKVIS Chameleon Plugin na pasta de Plug-ins de seu editor gráfico.

Por exemplo:

se você usar Photoshop CC 2022, CC 2021, CC 2020, CC 2019, CC 2018, CC 2017, CC 2015.5, copiá-lo no
Biblioteca/Suporte de Aplicação/Adobe/Plug-Ins/CC,

se você usar Photoshop CC 2015 copiá-lo no: Aplicações/Adobe Photoshop CC 2015/Plug-ins,

se você usar Photoshop CS6 copiá-lo no: Aplicações/Adobe Photoshop CS6/Plug-ins.
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Plugins de AKVIS em Mac 
(clique para ampliar)

Depois de instalação do programa AKVIS Chameleon, vai ver em menu dos Filtros/Efeitos de editor uma nova fôlha AKVIS –
> Chameleon.

A versão standalone do programa é executada por clique duplo no seu ícone.

Você também pode executar o programa de AKVIS no aplicativo Fotos escolhendo o comando Imagem -> Editar com (em
High Sierra e versões posteriores do macOS).
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COMO ATIVAR UM PROGRAMA AKVIS

Atenção! Durante o processo de ativação o seu computador deve estar conectado à Internet.

Se isto não for possível, oferecemos uma forma alternativa (veja como fazer a ativação desconectado).

 

Faça o download e instale o programa AKVIS Chameleon. Leia as instruções de instalação aqui.

Quando você executa a versão não registrada, uma janela inicial aparecerá com informações gerais sobre a versão e o
número de dias que restam em seu período de teste.

Você também pode abrir a janela Sobre o programa pressionando o botão   no Painel de controle do programa.

 

Clique no botão TESTAR para avaliar o software. Uma nova janela se abre com variações de licenças disponíveis.

Você não precisa registrar a versão de avaliação para testar todos os recursos do software. Basta usar o programa durante o
período de avaliação de 10 dias.

Durante o período de teste você pode tentar todas as opções e escolher o tipo de licença que você quiser. Selecione um dos
tipos de funcionalidades oferecidas: Home, Deluxe ou Business. Sua escolha de licença afetará quais recursos estarão
disponíveis no programa. Consulte a tabela de comparação para mais detalhes sobre os tipos de licença e as versões do
software.

Se o período de avaliação expirou, o botão TESTAR estará desabilitado.

 

Clique no botão COMPRAR para escolher e comprar a licença do produto.

Quando o pagamento é efetuado, você receberá um número de série para o programa no seu endereço de e-mail em poucos
minutos.

 

Clique no botão ATIVAR para iniciar o processo de ativação.
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Digite seu nome e o número de série do programa.

Selecione um modo da ativação do programa: pela conexão direta ou e-mail.

Conexão direta:

Recomendamos fazer a ativação pela conexão direta.

Nesta etapa o computador deve estar conectado à Internet.

Clique no botão ATIVAR.

O registo é finalizado!

Ativação por e-mail:

No caso de escolher a ativação via e-mail, uma mensagem é criada com todas as informações necessárias.

NOTA: Você pode usar esse método também para Ativação offline:

Se o seu computador não estiver conectado à Internet, você pode transferir a mensagem de ativação para outro
computador com ligação à Internet, através de USB, e enviar e-mail para: activate@akvis.com.

Por favor, não envie screenshot (imagem capturada da tela)! Basta copiar o texto e salvá-lo.

Precisamos do número de série do software, o seu nome e número de ID de Hardware (HWID) do seu computador.

Criaremos o arquivo de licença (Chameleon.lic) utilizando estas informações e enviaremos para o seu e-mail.

Salve o arquivo .lic (não abri-lo!) no computador onde você deseja registrar o software, na pasta  AKVIS em
documentos compartilhados (públicos):

No Windows 7, Windows 8, Windows 10:

Users\Public\Documents\AKVIS;

No Mac:

Users/Shared/AKVIS.

O registo será finalizado!
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Quando o programa estiver registrado, o botão COMPRAR transforma-se no botão UPGRADE que permite melhorar a sua
licença (por exemplo, alterar uma licença Home para Home Deluxe ou Business).
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ÁREA DE TRABALHO

AKVIS Chameleon pode funcionar como um programa autônomo ou como um plugin para editor de foto.

Standalone é uma aplicação autônoma, você pode abri-lo clicando no ícone do programa.

Para começar a versão autônoma, execute o programa diretamente:

Num computador Windows - selecione-o no menu Iniciar ou use o atalho do programa.

Num computador Mac - inicie o programa da pasta Aplicações.

Plugin é um módulo adicional para um editor de foto, por exemplo, para Photoshop.

Para chamar o plugin, selecioná-lo a partir de filtros do seu programa de edição de imagem.

Abra uma imagem que contém um objeto para colagem.

Selecione o objeto com qualquer ferramenta de seleção e acione o comando Chameleon – Grab Fragment no
menu Filtros do seu editor de imagens.

Abra uma imagem que será utilizada como fundo na colagem. Selecione o comando Chameleon - Make Collage
no menu Filtros.

A janela do programa AKVIS Chameleon parece assim:

Àrea de trabalho do AKVIS Сhameleon

Partes da janela do programa:

Na área esquerda do ambiente de trabalho do AKVIS Сhameleon aparece a Janela de imagem, com duas abas Antes e
Depois. A aba Antes mosrta dois imagens originais, a aba Depois - o resultado (collagem).

 

Na parte mais alta da janela pode se vê o Painel de controle com os seguintes botões:

O botão   abre a página Web do AKVIS Chameleon.

O botão   (somente na versão autônoma) abrir uma imagem de fundo. A tecla de atalho para o comando é Ctrl+O

no Windows, ⌘ +O  no Mac. Você também pode arrastar a imagem desejada para a área de trabalho do programa. A
versão standalone do AKVIS Chameleon suporta os formatos de arquivos BMP, JPEG, PNG e TIFF.
O botão   abrir uma imagem com o objeto.
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O botão   permite trocar a imagem de fundo (1) e a imagem do primeiro plano (2).

O botão   (somente na versão autônoma) salva a imagem no disco. A tecla de atalho é  Ctrl+S  no Windows,

⌘ +S  no Mac.

O botão   (somente na versão autônoma) aciona a impressão da imagem. A tecla de atalho é Ctrl+P  no Windows,

⌘ +P  no Mac.

O botão   importar ajustes predefinidos de um arquivo .chameleonFragment. É possível salvar uma imagem objeto

(fragmento) para usá-lo em outras fotomontagens. O arquivo conterá informações sobre a localização dos fragmentos,
os ajustes e as linhas.
O botão   permite salvar seus ajustes como um ajuste predefinido (preset). Os fundos são salvos para um arquivo

.chameleonFragment.
O botão   liga e desliga as guias.

O botão   apaga o último traçado. A tecla de atalho para o comando é Ctrl+Z  no Windows, ⌘ +Z  no Mac.

O botão   restaura o traçado. A tecla de atalho para o comando é Ctrl+Y  no Windows, ⌘ +Y  no Mac.

O botão   iniciar o processo de criação da fotomontagem. Use teclas de atalho:  Ctrl+R  no Windows, ⌘ +R  no

Mac.
O botão   (somente na versão plugin) permite aplicar o resultado à imagem e fechar a janela do AKVIS Chameleon.

O botão   fornece informações sobre o programa.

O botão   mostra a ajuda do programa. A tecla de atalho para o comando é F1 .

O botão   chama a Opções da caixa de Diálogo.

O botão   abre a janela que mostra as últimas notícias sobre Chameleon.

 

A parte esquerda da Janela de imagem lá é uma Barra de ferramentas. Os parâmetros para a ferramenta selecionada
aparecerão no Painel de ajustes.

Navegue e escale a imagem usando a janela de navegação - Navegador. Na janela de navegação pode se ver uma cópia da
imagem reduzida. A moldura vermelha mostra a parte da imagem que agora esta visível na Janela de imagem; a área do lado
de fora da moldura estará sombreada. Arraste a moldura para tornar visíveis outras partes da imagem. Para mover a moldura
traga o cursor para dentro da moldura, pressione o botão esquerdo do mouse e mantenha-o pressionado, mexa a moldura na
janela de navegação.

Janela de Navegação

Use o controle deslizante para dimensionar a imagem na Janela de imagem. Quando você move o controle deslizante para a
direita, a escala da imagem aumenta. Quando você move o controle deslizante para a esquerda, a escala da imagem diminui.

Além disso, você pode mover a imagem na Janela de imagem com as barras de rolagem ou mantendo pressionada a barra de
espaço e, em seguida, pressionando o botão esquerdo do mouse e movendo-o. A roda de rolagem do mouse pode mover a
imagem para cima e para baixo e exploração Ctrl  (⌘  no Mac) – e, ao mesmo tempo, usando a roda de rolagem irá mover a
imagem para a esquerda e para a direita. Mantendo a tecla Alt  (Option  no Mac) irá dimensionar a imagem. Clique com o
botão direito do mouse na barra de rolagem para ativar o menu de navegação rápida.

Você pode também mudar a escala da imagem entrando com um novo coeficiente dentro do campo de escala e pressione o
botão Enter  (Return  no Mac). O menu cair mostra alguns coeficientes frequantemente usados.

Você pode usar as teclas segintes para modificar a imagem escala +  e Ctrl++  (⌘ ++  no Mac) para aumentar a escala e -

e Ctrl+-  (⌘ +-  no Mac) para reduzir a escala.

Sob o Navegador há um Painel de ajustes onde você pode selecionar o Modo e ajustar parâmetros.

Sob o Painel de ajustes você pode ver dicas para o parâmetro e o botão sobre o qual passa o cursor.
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¿CÓMO FUNCIONA?

Siga as instruções para criar uma fotomontagem usando AKVIS Chameleon:

Passo 1. Abra dois imagens: uma imagem que será utilizada como fundo na fotomontagem e uma imagem que contém o
objeto que você deseja transferir para a imagem de fundo.

  

- Se você trabalha com a edição autônoma (arquivos nos formatos BMP, JPEG, PNG, TIFF):

Clique no botão   para abrir uma imagem de fundo e no botão   para abrir uma imagem com o objeto.

Você pode trocar imagens com  .

- Se você trabalha com o plugin:

Abra imagens no seu editor de fotos chamando o comando Arquivo -> Abrir ou utilizando a combinação de
teclas Ctrl+O  no Windows, ⌘ +O  no Mac.

Selecione o objeto com qualquer ferramenta de seleção. A seleção não precisa ser muito precisa.

Acione o comando AKVIS -> Chameleon – Grab Fragment (="pegar o fragmento") no menu Filtros/Efeitos do
seu editor de imagens.

AliveColors: Effects -> AKVIS -> Chameleon - Grab Fragment; 
Adobe Photoshop: Filter –> AKVIS –> Chameleon – Grab Fragment; 
Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Chameleon – Grab Fragment; 
Corel Photo-Paint: Effects –> AKVIS –> Chameleon – Grab Fragment.

Aparecerá uma mensagem indicando que o objeto ou fragmento de imagem selecionado está salvo para uso na
fotomontagem ("Fragmento está salvo").

Selecione a imagem que será utilizada como fundo na fotomontagem.

Então acione o comando AKVIS –> Сhameleon – Make Collage (="fazer uma colagem") no menu Filtros/Efeitos
do seu editor de imagens.

AliveColors: Effects -> AKVIS -> Chameleon - Make Collage; 
Adobe Photoshop: Filter –> AKVIS –> Chameleon – Make Collage; 
Corel PaintShop Pro: Effects –> Plugins -> AKVIS –> Chameleon – Make Collage; 
Corel Photo-Paint: Effects –> AKVIS –> Chameleon – Make Collage.

Passo 2. A janela do plugin AKVIS Chameleon se abrirá. A janela apresentará a imagem de fundo e o objeto inserido
sobre ela.
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Imagem no AKVIS Chameleon

Passo 3. Selecione o modo apropriado à finalidade que deseja (Montagem, Camaleão, Fusão ou Emersão, Dupla
exposição) no menu de opções que será mostrado à direta da janela de imagem.

Montagem. No modo Montagem o programa combina imagens para criar uma fotomontagem realista. Esta opção
é indicada para criar fotomontagens com pessoas (inserir a imagem de uma pessoa em uma nova imagem de fundo
ou paisagem).

Camaleão. No modo Camaleão o objeto inserido será ajustado automaticamente à imagem de fundo, da mesma
forma que um camaleão se adaptaria a um novo ambiente, ou seja, o objeto é mesclado na imagem de fundo e
suas cores são ajustadas às do novo ambiente.

Fusão. No modo Fusão o programa alisa as bordas do objeto inserido e as ajusta às variações de cores da
imagem de fundo e também faz com que o objeto fique semi-transparente de modo que a textura da imagem de
fundo pode ser vista através do objeto.

Emersão. No modo Emersão, assim como no modo Montagem, o programa combina imagens para criar uma
fotomontagem na qual as imagens não sejam mescladas. A diferença entre esses dois modos é que no modo
Emersão o fragmento inserido não se sobrepõe integralmente à imagem de fundo, mas fica encravada na imagem
de fundo de forma que apenas algumas partes da imagem fragmento ficam visíveis. Este modo permite
fotomontagens com objetos difíceis como árvores, etc.

Atenção! No modo Emersão é fundamental para fazer uma seleção precisa. Se necessário, processe as
bordas do fragmento antes de colá-lo na imagem principal.

Dupla exposição (para licenças  Home Deluxe e Business). O modo Dupla exposição é baseado na técnica
usada pelos fotógrafos. As duas imagens são sobrepostas numa única foto com o uso de diferentes modos de
mesclagem e levando em conta os valores de luminância. O mais popular é combinar cenas de paisagens com
retratos humanos em que uma silhueta escurece uma foto de sobreposição ou aparece isolada num fundo em
branco com uma imagem de superposição mostrando através dela.

Passo 4. Use a ferramenta Transformar  da Barra de ferramentas para mudar o tamanho, a posição e o ângulo

de rotação do objeto em relação à imagem de fundo. Se você pressionar o botão   (T ) uma moldura pontilhada irá

aparecer e o Painel de ajustes mostrará os parâmetros de transformação.
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Transformar o fragmento

Passo 5. Use a opção Guias para posicionar precisamente o fragmento na imagem de segundo plano. São as linhas
auxiliares, horizontal e vertical, que ajudam a especificar a posição exata do fragmento. Elas não aparecerão no
resultado final.

Guias

Para criar uma guia, clique no botão   no Painel de controle para exibir as réguas ao longo das margens da Janela
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imagem. Focalize o mouse sobre uma das réguas, pressione o botão esquerdo do mouse e arraste o cursor até o
centro da imagem. Você verá uma linha azul movendo com o cursor. Solte o botão do mouse no local desejado.

Para mover a diretriz criada, focalize o mouse sobre ela (o cursor se transformará em  ), pressione o botão esquerdo

do mouse e mova a linha para o local apropriado. Para remover a diretriz, arraste-a para fora da Janela imagem.

Nota: Você pode mover as guias somente na aba Antes com a ferramenta Transformar ativa.

Clique com o botão direito do mouse em   para chamar o menu Guias e defina os parâmetros de visualização:

Réguas. Quando essa opção é verificada, você pode ver as réguas ao longo das margens da Janela imagem.
Clique com o botão direito do mouse em uma régua para selecionar as unidades de medida (pixels, polegadas,
centímetros, etc.).
Guias. Quando essa opção é verificada, as guias previamente criadas são exibidas. Quando a opção é
desativada, as guias não são exibidas e não podem ser criadas.
Ajuste. Quando essa opção é verificada, os pontos de nós do fragmento juntam-se às guias ao movê-lo.
Bloquear guias. Quando essa opção é verificada, é impossível reposicionar as guias.
Limpar guias. Quando essa opção é verificada, todas as guias criadas são excluídas.

Passo 6. Ajuste o valor do parâmetro Opacidade. Este parâmetro é auxiliar e não influencia no resultado final!

Reduza o percentual de opacidade se é necessária alta precisão no posicionamento da imagem objeto (fragmento) na
imagem de fundo. Com 100% de opacidade o objeto não tem qualquer transparência. Quanto mais baixo o percentual de
opacidade, mais transparente o objeto fica em relação ao fundo.

Opacidade = 75%

Passo 7. Se necessário, você pode ajustar o brilho e o contraste das imagens de origem na seção  Pré-
processamento.
Passo 8. Use as ferramentas de seleção para determinar a área da imagem que deve ser considerada durante a criação
da colagem.
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Criação da seleção
Passo 9. Clique em  para iniciar o processo de criação da fotomontagem. O resultado será mostrado na janela

Depois.

Se não estiver satisfeito com o resultado é possível voltar à janela Antes, ajustar os parâmetros e clicar novamente em
 para iniciar um novo processo de montagem.

Passo 10. Opcionalmente, você pode ajustar os parâmetros de Pós-processamento para perfeccionar el resultado.
Passo 11. A colagem resultante pode ser modificado na aba Depois con o uso das ferramentas de pós-processamento:
Borrar , Desfocar  e Pincel histórico  (disponível apenas para as licenças Home Deluxe e Business).

Atenção! Se você altera os valores dos parâmetros e executa novamente o processamento da imagem, as
alterações feitas com as ferramentas de pós-processamento serão perdidas!

Passo 12. É possível salvar o fragmento para usá-lo em outras fotomontagens.

Para isso clique em  no Painel de contrôle aparecerá uma caixa de diálogo onde você deverá introduzir um nome

para o arquivo e indicar uma pasta onde deseja salvá-lo.

Desta forma o fragmento será salvo com a extensão  .chameleonFragment. O arquivo conterá informações sobre a
localização dos fragmentos, os ajustes e as linhas.

Para abrir um dos fragmentos que foram salvos, clique em  e escolha o fragmento que deseja.

Passo 13. Na versão autônoma você também pode imprimir sua pintura com .
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Result

Passo 14. Salve a imagem processada.

- Na versão autônoma:

Clique o botão   para abrir o diálogo Salvar como. Entre um nome para o arquivo, selecione o formato (TIFF,

BMP, JPEG ou PNG) e indique a pasta de destino.

- Na versão plugin:

Pressione o botão   para aplicar os resultados e fechar a janela do plugin. O AKVIS Chameleon será fechado

e a imagem resultante aparecerá na área de trabalho do editor de imagens.

Acione o diálogo Salvar como usando o comando do menu Archivo -> Salvar como, entre um nome para o
arquivo, selecione o formato da imagem e indique a pasta de destino.
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FERRAMENTAS E SUAS OPÇÕES

O painel esquerdo no AKVIS Chameleon (Barra de ferramentas) contém três grupos de ferramentas: ferramentas de pré-
processamento, de pós-processamento e  adicionais. Diferentes pincéis são visíveis dependendo da aba ativa - Antes ou
Depois.

Barra de ferramentas 
na aba Antes

Barra de ferramentas
na aba Depois

Dica:

Você pode usar os botões   e  para desfazer/refazer as operações feitas com as ferramentas:  , , , 

, , , .

 

Ferramentas de pré-processamento (na aba Antes):

Você pode usar ferramentas de seleção básicas ou automáticas para selecionar um fragmento para a colagem.

As ferramentas de seleção básicas permitem criar rapidamente seleções geométricas e de forma livre. São
especialmente úteis para obter uma forma de selecção precisa.

Atenção! Quando você usa ferramentas de seleção as alterações feitas com todas as outras ferramentas serão
canceladas. Por isso, é recomendável usar as ferramentas de seleção em primeiro lugar!

A ferramenta Pincel de seleção  permite o ajuste das seleções por meio da pintura da imagem.

A ferramenta Seleção retangular  permite selecionar áreas retangulares e quadradas. Arraste a área que

você deseja selecionar com o botão esquerdo do mouse.
A ferramenta Seleção elíptica  permite selecionar áreas elípticas ou circulares.

A ferramenta Laço  permitem criar seleções à mão livre. Arraste para desenhar uma linha da seleção próximo

de um objeto. Ao soltar o botão esquerdo do mouse, o contorno será fechado e o ponto final será conectado ao
ponto inicial.

A criação da seleção

Use as seguintes ferramentas para ajustar as opções de seleção:

O Modo de seleção define o resultado da interação de seleções:
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Nova seleção . Nesse modo uma nova seleção será criada. Se houver áreas selecionadas na imagem,

elas serão desmarcadas.
Adicionar à seleção . A área de seleção será aumentada, adicionando novos fragmentos.

Subtrair da seleção . Você pode remover as áreas não desejadas da seleção, ativando esse modo.

Inverter. O comando inverte a seleção.

Desmarcar. O comando cancela todas as seleções na imagem.

Aplicar. Pressione o botão para aplicar as seleção.

 

As ferramentas de seleção automáticas permitem escolher um fragmento para a colagem, criando um esboço. Edite os
contornos da imagem. Você vai precisar das seguintes ferramentas:

Lápis manter área . Use esta ferramenta para contornar a área do objeto que deverá fazer parte da

fotomontagem. Você pode ativar essa ferramenta pressionando a letra K  do teclado.

Lápis eliminar área . Use esta ferramenta para contornar partes desnecessárias do objeto, as partes irão

desaparecer. Você poderá ativar esta ferramenta pressionando a letra D  do teclado.

Borracha . Use esta ferramenta para apagar os contornos desenhados. Você pode ativar esta ferramenta

pressionando a letra E  do teclado.

Linhas de contorno no AKVIS Chameleon

Para fazer a linha reta, desenhá-lo com a tecla Shift  pressionada.

 

Use a ferramenta Transformar  da Barra de ferramentas para mudar o tamanho, a posição e o ângulo de rotação

do objeto em relação à imagem de fundo.
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Se você pressionar o botão   (T ) uma moldura pontilhada irá aparecer e o  Painel de ajustes mostrará os

parâmetros de transformação.

Mude o tamanho do objeto posicionando o cursor na moldura pontilhada. O cursor irá se transformar numa flecha de
duas direções  . Mantendo o botão esquerdo do mouse acionado, aumente ou diminua o tamanho do objeto. Além
disso, você pode redimensionar a imagem mudando os parâmetros L (largura) e Al (altura).

Há um sinal de proporção  /  entre os parâmetros  L e  Al. Se esta opção estiver habilitada a imagem será

redimensionada proporcionalmente, se estiver desabilitada, você poderá estabelecer seus próprios parâmetros.

Para fazer a rotação de um objeto, posicione o cursor para um dos ângulos marcados para obter um ponteiro de duas
flechas circulares , move o ponteiro mantendo o botão esquerdo do mouse pressionado. Você pode fazer a rotação

do objeto definindo o parâmetro A (angulo) com um valor entre -180 e 180 graus no Painel de ajustes.

Para mover um objeto, posicione o cursor no interior do objeto e ele se transformará numa cruz  . Mova o objeto

mantendo o botão esquerdo do mouse pressionado.

Giro horizontal  permite inverter o fragmento inserido horizontalmente (trocando os lados esquerdo e direito).

Giro vertical  permite inverter o fragmento inserido verticalmente (girando a imagem de cabeça para baixo).

 

Ferramentas de pós-processamento (na aba Depois, para Deluxe/Business):

Atenção! As ferramentas ,  e  estão disponíveis apenas para as licenças Home Deluxe e Business, na aba

Depois. Usá-los na etapa final. Se executa o processamento de novo , as mudanças realizadas com estas

ferramentas perderão-se!

As opções dessas ferramentas são mostradas em uma caixa pop-up que aparece depois de clicar com o botão direito do
mouse na imagem.

A ferramenta Borrar . A ferramenta é projetada para misturar cores na imagem e suavizar as bordas do fragmento

inserido.

Tamanho (1-300). A largura máxima de uma linha traçada pela ferramenta.

Dureza (0-100). O grau de indefinição das bordas do pincel. Quanto mais alto o valor do parâmetro, mais definida
se torna a borda do traço.

Força (1-100). A intensidade de tintas na pincelada. Quanto mais alto o valor deste parâmetro, mais a cor será
manchada.
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Antes de aplicar a ferramenta Borrar Usando a ferramenta Borrar

Antes de aplicar a ferramenta Desfocar Usando a ferramenta Desfocar

 

A ferramenta Desfocar . Use esta ferramenta para reduzir a nitidez das bordas do fragmento.

Parâmetros da ferramenta:

Tamanho (1-200). O diâmetro do pincel em pixels.

Dureza (0-100). A largura da borda externa da ferramenta, onde a imagem é parcialmente desfocada. Quanto
mais alto o valor do parâmetro, maior a área dentro do pincel onde a desfocagem é aplicada completamente.

Raio (0,1-10,0). Intensidade do efeito sobre uma imagem. Este parâmetro especifica a área onde pontos são
procurados para a desfocagem: em valores mais altos o raio de desfocagem é maior.

 

O Pincel histórico . A ferramenta funciona em um dos dois modos: restaura original (a caixa de verificação está

activada) ou remove as mudanças feitas com as ferramentas de pós-processamento (a caixa de seleção está
desativada).

Os parâmetros da ferramenta:

Tamanho (1-1000). A largura máxima com que a linha pode ser traçada com o pincel.
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Antes de aplicar a ferramenta Pincel histórico Usando Pincel histórico

Dureza (0-100). O grau de indefinição das bordas do pincel. Quanto mais alto o valor do parâmetro, mais definida
se torna a borda do pincel. Próximo dos 100%, o limite entre a borda do pincel e o fundo será mais distinta; em
valores mais baixos a transição entre tais áreas será mais suave.

Força (1-100). O grau de restauração do estado original. Em valores mais baixos haverá menor restauração e
maior mistura com o efeito; em valores próximos a 100% a condição original será restaurada de maneira mais
completa.

Na lista suspensa Restaurar você pode escolher o que a ferramenta irá restaurar: Imagem de fragmento,
Imagem de fundo ou Resultado de processamento.

 

Ferramentas adicionais (disponível em ambas as abas, para todas as licenças):

A ferramenta Mão  é desenhada para rolar a área exibida da imagem se, na escala escolhida, a imagem toda não

cabe na janela. Para mover a imagem você deve pressionar este botão, colocar o cursor sobre a imagem, pressionar o
botão esquerdo e, mantendo-o pressionado, mover a imagem na janela. A tecla de atalho é H .

Dê um clique duplo no ícone  , na barra de ferramentas, para ajustar a imagem à janela de imagem.

A ferramenta Zoom  ativa a ferramenta Zoom que é desenhada para alterar a escala da imagem. Para aumentar a

escala, pressione o botão e clique com o botão esquerdo na imagem. Para diminuir a escala, clique com o botão
esquerdo com tecla Alt  pressionada. A tecla de atalho é Z .

Dê um clique duplo no ícone  , para fazer a escala de imagem a 100% (o tamanho real).
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Brilho = 0 Brilho = -30

CORREÇÃO DE TOM

Use as configurações de Pré-processamento e Pós-processamento para fazer alguns ajustes nas imagens de origem e na
colagem criada. O resultado será ainda mais vívido, expressivo e espetacular.

Colagem antes e depois do processamento adicional

 

Parâmetros de Pré-processamento:

Você pode mudar os tons das imagens antes de criar uma colagem (na aba Antes).

Ajuste o brilho e o contraste das imagens originais nas abas Imagem 1 e Imagem 2.

Brilho (-100..100). O parâmetro permite alterar o brilho da imagem. Cuando o valor deste parâmetro aumenta, todos os
pixels da imagem ficam mais claros, e cuando o valor diminui, ficam mais escuros.

Contraste (-100..100). O parâmetro permite aumentar (quando o valor é maior que 0) ou diminuir (quando o valor é
menor que 0) a diferença entre as áreas claras e escuras da imagem.
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#preprocessing
#postprocessing


Contraste = 0 Contraste = 40

Brilho = -30 Brilho = 20

Contraste = -40 Contrast = 10

 

Parâmetros de Pós-processamento:

Você pode modificar a colagem criada: ajustar o tom, adicionar o ruído, converter a imagem em preto e branco (na aba
Depois).

Brilho (-100..100). O parâmetro permite alterar o brilho da imagem. Cuando o valor deste parâmetro aumenta, todos os
pixels da imagem ficam mais claros, e cuando o valor diminui, ficam mais escuros.

Contraste (-100..100). O parâmetro permite aumentar (quando o valor é maior que 0) ou diminuir (quando o valor é
menor que 0) a diferença entre as áreas claras e escuras da imagem.

Ruído (0-10). Este parâmetro permite adicionar ruído à imagem.
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Ruído = 0 Ruído = 7

Colagem de cores Colagem em preto e branco

Preto y branco. Ative a caixa de verificação para converter a colagem em tons de cinza.
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OPÇÕES DO PROGRAMA

O botão   chama as Opções da caixa de diálogo. A caixa de diálogo Opções parece assim:

Idioma. Selecione um idioma na lista drop-down.
Escala da interface. Escolha o tamanho dos elementos da interface. Quando definido em Auto, a escala do espaço de
trabalho do programa irá adaptar-se automaticamente para a resolução de tela.
Tema da interface: Claro ou Escuro. Selecione o estilo da interface do programa.
Escala inicial da imagem. Este parâmetro define a forma como a imagem é dimensionada na Janela de imagem
depois da aberta. O parâmetro pode assumir um dos dois valores:

- ampliação da imagem Ajustar à visão. O tamanho ajusta-se para que a imagem seja completamente visível na
Janela de imagem; 
- se a opção 100% é selecionada, a imagem não escala. Geralmente, quando a escala = 100%, somente parte
da imagem será visível.

Documentos recentes (somente na versão standalone). Para abrir a lista das imagens recentamente abertas, clique
com o botão direito do mouse no   para imagens recentes de fundo, no  para imagens recentes de primeiro

plano. Máximo: 30 ficheiros.
Descrição de parámetros. Você pode escolher como mostrar as dicas:

- Embaixo da janela de imagem. 
-  Embaixo do Painel de ajustes. 
-  Ocultar.

Bloquear o Painel de controle. Se a caixa é selecionada, o painel superior é sempre visível. Quando a caixa é
desativada, é possível ocultar/mostrar o Painel de controle clicando no pequeno botão triângular (no meio do painel). O
painel minimizado será mostrado ao mover o cursor sobre ele.
Aceleração GPU. Activa o modo do processamento usando la placa de vídeo. A caixa só está activa se um computador
tem uma placa de vídeo compatible. A velocidade de processamento de imagem depende diretamente de la placa de
vídeo.

Para salvar as mudanças efetuadas na janela Opções pressione OK.

Clique no botão Padrão para restaurar os valores padrão.

 

IMPRIMIR A IMAGEM

AKVIS Chameleon

31



IMPRIMIR A IMAGEM

Na versão autônoma (standalone) do AKVIS Chameleon você pode imprimir a imagem.
Pressione o botão   para abrir as opções de impressão.

Opções de impressão no AKVIS Chameleon

Ajuste os parâmetros que aparecem no Painel de ajustes:

Escolha uma impressora a partir da lista de dispositivos disponíveis, defina a resolução desejada eo número de cópias
para imprimir.

No grupo Orientação selecione a posição do papel: Retrato (vertical) ou Paisagem (horizontal).

Clique no botão Configurar página para abrir uma caixa de diálogo na qual você pode escolher o tamanho do papel e
sua orientação, bem como as margens da impressão.

Pressione o botão Reiniciar margens para retornar as margens da página no tamanho padrão.

Você pode mudar o tamanho da imagem impressa ajustando os parâmetros Escala, Largura, Altura ea opção Ajustar
à página. Esses parâmetros não têm efeito sobre a imagem em si, só na versão impressa. É possível mudar o tamanho
da cópia impressa, especificando um valor em % ou inserindo novos valores de Largura e Altura.

Para ajustar o tamanho da imagem para o tamanho do papel, selecione Ajustar à página.

É possível mover a imagem na página com o mouse ou alinhá-lo com os botões de flechas.

Você pode ativar Moldura para a imagem e ajuste sua largura e cor.

Selecione a Cor de fundo clicando na placa de cores.

Na aba Página você pode ajustar a impressão das múltiplas cópias da imagem em uma única folha.

AKVIS Chameleon

32



Impressão da página
Cópias por página. O parâmetro permite especificar o número de cópias da imagem em uma página.
Horizontalmente e Verticalmente. Esses parâmetros indicam o número de linhas e colunas para as cópias da
imagem na página.
Espaçamento. O parâmetro define as margens entre as cópias da imagem.

Na aba Poster é possível ajustar a impressão da imagem em várias páginas para a junção subsequente em uma imagem
grande.

Impressão do poster
Páginas. Se a caixa de seleção estiver ativada, você pode especificar o número máximo das páginas em que a
imagem será dividida. A escala da imagem se ajusta a este número das folhas. Se a caixa de seleção é
desativada, o programa automaticamente seleciona o número ideal das páginas de acordo com o tamanho real da
imagem (escala = 100%).
Margens de adesivo. Se a caixa de seleção estiver ativada, você pode ajustar a largura do preenchimento para
ligação de folhas. As margens serão adicionados para a parte direita e inferior de cada seção.
Linhas de corte. Ative a caixa de seleção para exibir as marcas de cortes nas margens.
Mostrar números. Se a caixa de seleção estiver ativada, nas margens será impresso um número de ordem de
cada seção, por uma coluna e uma linha.

Para imprimir uma imagem com os parâmetros escolhidos pressione o botão Imprimir. 
Para cancelar e fechar as opções de impressão pressione o botão Anular.

Clique no botão Propriedades... para abrir a caixa de diálogo do sistema que permite acessar ás configurações avançadas e
enviar o documento para a impressora.
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Imagens originais

MODO MONTAGEM

AKVIS Chameleon propõe 5 modos de criação de montagens de fotos: Montagem, Camaleão, Fusão, Emersão e Dupla
exposição.

No modo Montagem o programa combina as imagens de forma a criar uma fotomontagem suave, sem irregularidades e bordas
visíveis. Permite transferir objetos selecionados para uma nova imagem de fundo e faz com que partes irrelevantes do objeto
(fragmento de imagem) se mesclem e desvaneçam. O objeto não perde suas características e variações de cores e
opacidade. Este modo é o mais indicado para a criação de fotomontagens com pessoas (transferência de uma pessoa para
uma nova imagem de fundo).

Resultado

Siga as instruções para criar uma fotomontagem utilizando o modo Montagem do AKVIS Chameleon:

Passo 1. Clique no botão   para abrir uma imagem de fundo e no botão   para abrir uma imagem com o objeto.

 

Atenção: Se você trabalha com o plugin, fazer estes passos.

Passo 2. Use a ferramenta Transformar  para mudar o tamanho, a posição e o ângulo de rotação do objeto em

relação à imagem de fundo. Ajuste o valor do parâmetro Opacidade.
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Passo 3. Use as ferramentas de seleção para seleccionar um fragmento da colagem e marcar áreas não desejadas.

Passo 4. Clique no botão   para iniciar o processo de criação da fotomontagem. O resultado será mostrado na pasta

Depois.
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Se você não estiver satisfeito com o resultado, alterne para a janela Antes e desenhe os contornos mais precisamente.
Então pressione o botão   novamente.

Você também pode usar as  ferramentas de pós-processamento (Borrar , Desfocar  e Pincel histórico )

para editar o resultado.
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FOTOGRAFIA DE CAÇA

Este tutorial foi criado em AliveColors, mas você pode fazer o mesmo em qualquer outro editor de fotografia compatível com
o plugin AKVIS Chameleon.

  

Passo 1. Abra a fotografia que contém um fragmento para a colagem de fotografia nova.

Passo 2. Selecione o fragmento para uma colagem. Em nosso caso é o menino com uma máquina fotográfica. A seleção
não necessita ser precisa, como o plugin Chameleon oferece a técnica avançada que permite quase separar
automaticamente.

Selecione os comandos Effects -> AKVIS -> Chameleon – Grab Fragment (="capturar o fragmento") do menu
principal. Você verá uma mensagem que diz que o fragmento foi salvado.

Passo 3. Abra a imagem de fundo.
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Passo 4. Selecione os comandos Effects -> AKVIS -> Chameleon – Make Collage (="fazer uma colagem").

AKVIS Chameleon plugin abrirá e você verá a imagem de fundo e o fragmento de imagem sobre ele na aba Antes na
área de trabalho.

Por padrão o modo Montagem está ativo. Nós continuaremos trabalhando neste modo.

Passo 5. Selecione a ferramenta Transformar  na e ajuste a posição do menino no fundo.

Passo 6. Agora nós deveremos adquirir partes livres irrelevantes do fragmento, como sòmente a figura do menino
deverá ser mantida.

Primeiro de tudo, selecione a ferramenta Borracha  e exclua automaticamente a linha azul desenhada.

Selecione a ferramenta Lápis eliminar área  arraste e desenhe a linha ao redor do menino. Então ative a
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ferramenta Lápis manter área  e desenhe dentro da figura do menino; neste modo você define que áreas do

fragmento deverão ser mantida e se aparecem nas montagens das fotografias finais.

Passo 7. Clique em  para iniciar o processo da criação da montagem da fotografia. O resultado será mostrado na

aba Depois.

Passo 8. Clique em .

O plugin AKVIS Chameleon fechará e você verá a montagem da foto na área de trabalho do seu editor de foto.

Passo 9. Para a fotografia parecer mais realística desenhe as laminas da grama sobre os sapatos do menino: selecione
a ferramenta Color Brush, ajuste seu tamanho e cor (você pode usar o "apontador da cor" para apontar o a cor da
grama na fotografia) e desenhar algumas linhas em sobre os sapatos do menino. Então aponte outra cor e desenhe
outras linhas:
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Aqui está o resultado final:

O menino quase não poderia imaginar, enquanto deixava a casa naquele dia, ele foi achados na companhia de uma
girafa no meio de pradaria africana.
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PAÍS DAS MARAVILHAS

Qualquer um provavelmente conhece a história de Alice no País das maravilhas. Durante a história, a garotinha Alice muda de
tamanho, as vezes crescendo mais do que uma casa enquanto depois vai encolhendo até o tamanho de um rato. Você pode
conseguir o mesmo efeito com o AKVIS Chameleon. Você pode experimentar com qualquer tamanho, até reduzindo o objeto
para o tamanho médio de um cogumelo.

Nós trabalhamos no AliveColors, mas você pode usar qualquer editor gráfico que seja  compatível com o plugin do AKVIS
Chameleon.

 

Passo 1. Abra a imagem no editor gráfico. Escolha qualquer uma que você queira para selecionar o fragmento. Faça
uma duplicata da camada de fundo e selecione ela pressionando Ctrl+A .

Passo 2. Pegue o fragmento através do menu (Effects –> AKVIS –> Chameleon – Grab Fragment). Você irá, então,
ver uma mensagem comprovando que aquele fragmento foi salvo.
Passo 3. Troque para o fundo da imagem. Duplique a camada de fundo. Selecione Effects –> AKVIS –> Chameleon –
Make Collage no menu. A janela do plugin AKVIS Chameleon abrirá. O fundo da imagem, com o fragmento copiado
acima dele, será mostrado na aba Antes.
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Primeiramente o modo Montagem será escolhido por padrão e será usado aqui.

Passo 4. Ative a ferramenta Transformar  na Barra de ferramentas. Reduza o tamanho do fragmento, corte-o, e

então o coloque na posição desejada. Mude a Opacidade para 75% para ter uma melhor ideia de onde precisamente
colocar o fragmento.
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Passo 5. Agora precisamos remover as áreas indesejadas no fundo para então somente a garota permanecer. Ative o
Lápis manter área  e desenhe uma linha dentro dos limites da menina. Então ative o Lápis eliminar área  e

desenhe uma linha ao redor das bordas da menina. Tudo que estiver do lado de fora da linha vermelha será apagado,
enquanto que tudo que estiver dentro da linha azul será preservado. O limite passará entre essas duas linhas.

Passo 6. Pressione  para começar a criar uma montagem. O resultado será mostrado na aba Depois.
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Passo 7. Clique no . O plugin AKVIS Chameleon será fechado e a montagem irá aparecer no editor gráfico.

Passo 8. Vamos fazer a mão da menina aparecer como se estivesse atrás do cogumelo. Selecione a ferramenta Pincel
histórico  na barra de ferramentas e processe o braço e a mão da garota. Para facilitar o seu trabalho, selecione a

opacidade da camada para 70%.

Agora precisamos fazer com que algumas lâminas de grama apareçam como se estivessem na frente da garota. Use o
Pincel histórico novamente. Reduza a opacidade da camada e desenhe as laminas de grama para que apareçam na
frente do fundo da imagem.

E aqui está o resultado final:
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MODO CAMALEÃO

AKVIS Chameleon propõe 5 modos de criação de montagens de fotos: Montagem, Camaleão, Fusão, Emersão e Dupla
exposição.

No modo Camaleão o objeto inserido será ajustado automaticamente à imagem de fundo, da mesma forma que um camaleão
se adaptaria a um novo ambiente, ou seja, o objeto é mesclado na imagem de fundo e suas cores são ajustadas às do novo
ambiente.

Imagens originais Resultado

Siga as instruções para criar uma fotomontagem usando o modo Camaleão do AKVIS Chameleon.

Passo 1. Abra uma imagem que será utilizada como fundo na futura fotomontagem   e uma imagen com o objeto

que deseja transferir para um novo fundo .

 

Atenção: Se você trabalha com o plugin, fazer estes passos.

Passo 2. Selecione o modo Camaleão no menú rápido do Painel de ajustes.
Passo 3. Use a ferramenta Transformar  para mudar o tamanho, a posição e o ângulo de rotação do objeto em

relação à imagem de fundo.

Ajuste o valor do parâmetro Opacidade.
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Passo 4. Use as ferramentas de seleção para seleccionar um fragmento da colagem e marcar áreas não desejadas.

Passo 5. Ajuste a opção Transição suave.

Nota: Funciona só se a imagem tem traços.

Quando a opção é desativada, anti-aliasing ocorre somente ao longo das fronteiras dos traços vermelhos. Quando
estiver ativado, anti-aliasing irá ocorrer em toda a área entre os traços vermelho e azul. A suavidade da transição
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Transição suave é desativada Transição suave é ativada

depende da distância entre os traços vermelho e azul.

Traços vermelho e azul

Atenção: Este parâmetro deve ser usado com cuidado. Pode desfocar pequenos detalhes ao longo das bordas do
fragmento inserido.

Passo 6. Clique no botão   para iniciar o processo de criação da fotomontagem. O resultado será mostrado na pasta

Depois.
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Você também pode usar as  ferramentas de pós-processamento (Borrar , Desfocar  e Pincel histórico )

para editar o resultado.
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Imagens originais

VELEJAR ALÉM DO PÔR DO SOL

AKVIS Chameleon permite criar colagens de fotografias rapidamente com um resultado realístico.

No tutorial seguinte nós usaremos o modo Camaleão do programa para transferir os iates de uma imagem para outra. Neste
modo o programa suaviza as bordas dos objetos e ajusta sua gama de cor para o fundo novo.

Resultado

Levará só varios minutos:

Passo 1. Abra a fotografia com os iates em seu editor de fotografia compatível com o plugin AKVIS Chameleon.
Selecione o objeto que você quer transferir para outra imagem com qualquer ferramenta de seleção.

Dica: Na versão autônoma (standalone) você pode desenhar os contornos com os lápises azul e vermelho.
Estas ferramentas também estão disponíveis no plugin. Permitem editar a seleção.

Passo 2. Chame Efeitos -> AKVIS -> Chameleon – Grab Fragment (pegar fragmento) do menu do editor de
fotografia para salvar o fragmento na prancheta.

Se tudo for feito corretamente, você verá uma mensagem informando que o objeto selecionado foi salvo na prancheta.

Passo 3. Agora abra a imagem com o pôr do sol.
Passo 4. Chame o comando Efeitos -> AKVIS –> Сhameleon – Make Collage (fazer colagem) do menu.

A janela do AKVIS Chameleon vai abrir. A janela vai mostrar a imagem do sol como pano de fundo e os iates colados
sobre ele.

Passo 5. Selecione o modo Camaleão no menu drop-down no Painel de ajustes.
Passo 6. Você pode ajustar a posição do objeto colado usando a ferramenta  Transformar  da  Barra de

ferramentas.

Para mover um objeto levando um cursor dentro do objeto, o cursor vai se transformar em uma cruz . Mova o objeto

mantendo o botão esquerdo do mouse pressionado.

Para alterar o tamanho do objeto alterar os parâmetros L (Largura) e A (Altura).
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No nosso caso, ter reduzido a parâmetros L e A de 100% para 60%.

Passo 7. Pressione  para iniciar o processo de criação de colagem. O resultado será mostrado na aba Depois.

Passo 8. Pressione  para aplicar o resultado e fechar a janela do plugin.
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Imagens originais

MUDANDO A APARÊNCIA

Olhos dizem muito sobre uma pessoa, transmitem sentimentos, caráter e emoções. Se você mudar os olhos, toda a aparência
da pessoa muda drasticamente.

AKVIS Chameleon permite trocar os olhos, nariz, orelhas, ou o que você quiser, de uma pessoa pelos retirados de uma foto
de outra pessoa.

Por exemplo, vamos substituir os olhos azuis da menina do lado esquerdo pelos olhos castanhos da menina à direita.

Resultado

Passo 1. Abra a foto com a menina de olhos castanhos, em seu editor de fotos compatible com o plugin AKVIS
Chameleon. Selecione os olhos com qualquer ferramenta de seleção.

Passo 2. Copie a área selecionada: chamando Efeitos -> AKVIS -> Chameleon - Grab Fragment no menu do editor
de fotos, para guardar o fragmento na área de transferência.
Passo 3. Volte para a primeira imagem e chame o comando Efeitos -> AKVIS -> Chameleon - Make Collage a partir
do menu.

A janela do AKVIS Chameleon com a menina e os olhos colados será aberta.

Passo 4. Selecione o modo Camaleão no menu drop-down no Painel de ajustes.
Passo 5. Altere o tamanho e a posição do fragmento sobre o fundo usando a ferramenta Transformar  da Barra

de herramientas.
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Passo 6. Clique no botão   para iniciar o processo de colagem. O resultado será mostrado na aba Depois.

Passo 7. Clique no botão   para aplicar o resultado e fechar a janela do plugin.

Você pode experimentar com outras partes do corpo com a mesma facilidade.
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FUSÃO

AKVIS Chameleon propõe 5 modos de criação de montagens de fotos: Montagem, Camaleão, Fusão, Emersão e Dupla
exposição.

No modo Fusão o programa alisa as bordas do objeto inserido e as ajusta às variações de cores da imagem de fundo e
também faz com que o objeto fique semi-transparente de modo que a textura da imagem de fundo pode ser vista através do
objeto.

Imagens originais Resultado

Siga as instruções para criar uma fotomontagem utilizando o modo Fusão do AKVIS Chameleon.

Passo 1. Abra uma imagem que será utilizada como fundo na futura fotomontagem   e uma imagen com o objeto

que deseja transferir para um novo fundo .

 

Atenção: Se você trabalha com o plugin, fazer estes passos.

Passo 2. Selecione o modo Fusão no menú rápido Modo do Painel de ajustes.
Passo 3. Use a ferramenta Transformar  para mudar o tamanho, a posição e o ângulo de rotação do objeto em

relação à imagem de fundo.

Ajuste o valor do parâmetro Opacidade.
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Passo 4. Use as ferramentas de seleção para seleccionar um fragmento da colagem e marcar áreas não desejadas.

Passo 5. Ajuste a opção Transição suave.

Nota: Funciona só se a imagem tem traços.

Quando a opção é desativada, anti-aliasing ocorre somente ao longo das fronteiras dos traços vermelhos. Quando
estiver ativado, anti-aliasing irá ocorrer em toda a área entre os traços vermelho e azul. A suavidade da transição
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depende da distância entre os traços vermelho e azul.

Atenção: Este parâmetro deve ser usado com cuidado. Pode desfocar pequenos detalhes ao longo das bordas do
fragmento inserido.

Passo 6. Clique no botão   para iniciar o processo de criação da fotomontagem.

Você também pode usar as  ferramentas de pós-processamento (Borrar , Desfocar  e Pincel histórico )

para editar o resultado.
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Imagens originais

PINTURA EM MADEIRA

O modo Fusão do AKVIS Chameleon plugin permite colar um objeto em um novo plano de fundo de modo que a textura do
fundo seja visível. No exemplo seguinte, mostraremos como colar uma maçã dentro numa tábua de madeira que é vista como
se a maçã fosse acoplada à tábua áspera de madeira.

Usaremos a foto da tábua de madeira (à esquerda) como plano de fundo, e a foto de uma suculenta maçã (à direita) como
objeto que será colado.

Resultado

Siga as instruções para criar o efeito de pintura numa superfície áspera.

Passo 1. Abra estas imagens no Adobe Photoshop.

Nota: Você também pode usar qualquer outro editor de fotos compatível com AKVIS Chameleon. Neste caso, você
deveria selecionar a maçã com a ferramenta de seleção disponível em seu editor de fotos (não com o modo Máscara
Rápida: passos 2-6) e ir diretamente para o Passo 7 deste tutorial.

Passo 2. Escolha o modo Máscara Rápida pressionando o botão   na Barra de ferramentas ou a tecla Q .

Passo 3. Selecione o Lápis da Barra de ferramentas pressionando o botão   ou a tecla B .

Passo 4. Pinte a maçã No modo Máscara Rápida usando um lápis de ponta forte (Hardness = 100%).

Passo 5. Escolha voltar ao modo padrão pressionando o botão   na Barra de ferramentas ou a tecla Q .

Passo 6. Inverta a seleção chamando o comando  Select -> Inverse ou usando a combinação de teclas
Ctrl+Shift+I .

Passo 7. Copie a maçã selecionada chamando o comando Filtro -> AKVIS -> Chamaleon - Extrair Objeto (Filter ->
AKVIS -> Chameleon - Grab Fragment) de seu editor de fotos.

Se tudo estiver correto, você verá uma mensagem alertando que o objeto selecionado foi salvo.

Passo 8. Volte para a foto com a superfície de madeira. Chame o comando Filtro -> AKVIS -> Chamaleon - Fazer
Colagem (Filter -> AKVIS -> Chamaleon - Make collage) no menu de seu editor de fotos.
Passo 9. A janela do AKVIS Chameleon abrira contendo a superficie de madeira como plano de fundo e a maca
colada.
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Passo 10. Selecione o modo Fusão no menú rápido Modo do Painel de ajustes.
Passo 11. Escolha a posição e o tamanho da mação usando a ferramenta  Transformar  d a  Barra de

ferramentas.

Passo 12. Clique em  para iniciar o processo de criação de colagem. O resultado será exibido Depois do separador.

Passo 13. Clique em  para aplicar o resultado e feche a janela do plugin.

Como resultado, teremos uma maçã desenhada numa superfície de madeira.

Da mesma forma, você pode criar pinturas papel amassado, tecido cru, etc.
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CARTÃO DE NAMORADOS

Este exemplo mostra como criar um cartão de Dia de Namorados para seus entes queridos. Com o programa de criação de
colagem AKVIS Chameleon é simples, além de tornar o processo criativo um prazer. Seu presente será original e único.

Você precisará de:

- Adobe Photoshop (ou qualquer editor gráfico que suporte o Plugin AKVIS Chameleon),

- O plugin AKVIS Chameleon,

- Uma imagem básica para um cartão (para nosso futuro namorado ou namorada, uma imagem de pétalas de rosa será
ideal),

- Uma figura de moldura (nós ja escolhemos uma imagem com uma moldura de figuras de gelo),

- Um pouco do seu tempo.

Vamos continuar a criação de um cartão de Dia de Namorados:

Passo 1. Vamos abrir as imagens com que o cartão será criado no Adobe Photoshop.

 

Passo 2. Vamos combinar a imagem de pétalas com a moldura de gelo:
Vá para a imagem das pétalas e escolha Select -> All no menu;
Copiando a seleção: vamos escolher no menu Filtro -> AKVIS -> Chamaleon - Extrair Objeto;
Vamos para a imagem da moldura de gelo. Selecione Filtro -> AKVIS -> Chamaleon - Fazer Colagem. O janela
do plugin AKVIS Chameleon abrirá. Na guia Antes estará a imagem da moldura de gelo com a imagem das
pétalas acima.

Selecione o modo Fusão no menú rápido Modo do Painel de ajustes.
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Com a ferramenta Transformar  da Barra de ferramentas vamos escolher o tamanho da imagem das

pétalas para que ela cubra completamente o quadro.

Inicie o processo de criação da colagem pressionando o botão  . O resultado será mostrado Depois d o

separador.
Pressione o botão   para aceitar as mudanças e retornar ao editor gráfico.

Nesta fase, você terá a seguinte imagem:

Passo 3. Qual é o cartão que nao tem uma inscrição? Especialmente de Namorados. O tetxo pode dizer qualquer coisa,
mas não esqueça, é mais agradável receber uma mensagem pessoal. Em nosso exemplo, nos limitaremos a frases
genéricas.

Portanto, vamos adicionar uma inscrição:

No Painel de Ferramentas , vamos escolher a ferramenta Horizontal Type.
Então, definiremos os parâmetros do texto: Fonte = Chiller, Tamanho = 150, Efeito = Smooth, e Cor = Vermelho
(no Painel de Opções da ferramenta Horizontal Type).
Vamos clicar na imagem e inserir algum texto (por exemplo: “I love you”). A inscrição será criada em outra
camada.
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Agora, vamos adicionar alguns efeitos ao texto. Uma vez que a inscrição está em uma camada separada,
aplicaremos os efeitos de camada Outer Glow, Inner Glow e Satin. Estes serão aplicados com os seguintes
comandos: Layer -> Layer Style -> Outer Glow / Inner Glow / Satin.

Passo 4. Vamos adicionar agora alguns corações para tornar o cartão de namorados mais romântico. Isto não deverá
ser muito difícil, uma vez que alguns editores gráficos têm conjuntos de formas padrão.

No Painel de Ferramentas , nós deveremos escolher a ferramenta Custom Shape.
No Painel de Opções da ferramenta Custom Shape, poderemos escolher dentre uma variedade de figuras.
Escolheremos Card Heart.
Vamos colocar o coração em uma nova camada.

Ainda na camada do coração, nós deveremos aplicar os efeitos Drop Shadow, Inner Shadow, Bevel and
Emboss. Eles serão executados através dos comandos  Layer -> Layer Style -> Drop Shadow / Inner
Shadow / Bevel and Emboss.
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Você deverá girar ligeiramente o coração com o comando Edit -> Free Transform.
Vamos criar uma dupla camada de coração executando o comando Layer -> Duplicate Layer.
Agora, vamos mover o segundo coração um pouco para a direita e transforma-lo com o comando Edit -> Free
Transform.

Tudo o que é preciso é ajustar o arranjo da inscrição e dos corações no cartão e ele está pronto! Para ver o cartão em
tamanho real (e em plena beleza) clique sobre a imagem.
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Imagens originais

MODO EMERSÃO

AKVIS Chameleon propõe 5 modos de criação de montagens de fotos: Montagem, Camaleão, Fusão, Emersão e Dupla
exposição.

No modo Emersão, assim como no modo Montagem, o programa combina imagens para criar uma fotomontagem na qual as
imagens não sejam mescladas. 
A diferença entre esses dois modos é que no este modo o fragmento inserido não se sobrepõe integralmente à imagem de
fundo, mas fica encravada na imagem de fundo de forma que apenas algumas partes do fragmento ficam visíveis. Este modo
permite fotomontagens com objetos difíceis como árvores, etc.

Resultado

O modo se chama Emersão porque o que se faz é emergir partes do fundo através do objeto. Esta característica o distingue
dos outros três modos que trabalham principalmente com o objeto em si e não com a imagem de fundo.

Siga estes passos para criar uma fotomontagem No modo Emersão do AKVIS Chameleon:

Passo 1. Clique em  e  para abrir imagens.

Neste exemplo, temos um efeito como se essas imagens trocarem de lugar. A imagem de fundo virá ao primeiro plano,
devido ao efeito de "emersão", e a segunda foto terá um aspecto do novo plano de fundo para a imagem.

 

Se você trabalha com o plugin, fazer os passos (3-5).

Passo 2. Selecione o modo Emersão no menú rápido Modo do Painel de ajustes.
Passo 3. Use a ferramenta Transformar  para mudar o tamanho, a posição e o ângulo de rotação do objeto em

relação à imagem de fundo.

Ajuste o valor do parâmetro Opacidade.
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Passo 4. Use as ferramentas de seleção para seleccionar um fragmento da colagem e marcar áreas não desejadas.

Dica: Para essas imagens nós não precisamos fazer a seleção aqui. Não faz sentido fazer isso, uma vez que a
imagem usada como um fragmento (neste caso, o céu nebuloso) se tornará maior que o fundo após a
transformação e move para além das fronteiras. Na maioria dos casos, por exemplo, aqui, este modo requer
uma seleção precisa do objeto incorporado.

Passo 5. Defina as áreas que serão substituídas por pedaços do objeto. As áreas serão definidas de acordo com suas
cores. Os seguintes parâmetros estão disponíveis:

Côres. Este campo contém uma paleta de cores que serão levadas em consideração no processamento da
imagem. Todos os pixels da imagem de fundo que contenham as cores definidas na paleta e cores
semelhantes serão substituídas com pedaços do objeto inserido.

Paleta da côres

A paleta têm seis quadrados para opção de cores. Por padrão (default) os quadrados serão mostrados vazios. Se
você iniciar o processamento da imagem agora, todos os pixels da imagem de fundo continuarão os mesmos e
você obterá a mesma imagem de fundo como resultado, não incorporando nada do objeto selecionado.

Para escolher uma cor, clique em um dos quadrados vazios, o cursor se transformará em um conta-gotas e você
poderá escolher uma cor da imagem do fundo clicando com o a tecla esquerda do mouse. O quadrado passará a
mostrar a cor selecionada.

Para trocar a cor do quadrado, clique com o botão esquerdo do mouse sobre ela e escolha uma nova cor na
imagem de fundo.

Para apagar uma cor, dê um clique com o botão direito do mouse sobre o quadrado o que fará com que ele volte
ao estado padrão (vazio).

Limitação. Este parámetro define pixels (zonas) da imagem de fundo que serão substituídas com os pixels do
objeto. Com o valor mínimo desse parámetro, somente as cores da paleta participarão do processo. Se o valor do
parámetro for aumentado, as cores similares às da paleta serão substituídas também. Quanto mais alto for o valor
do parâmetro mais pixels da imagem de fundo serão substituídos com os pixels do objeto. O objeto será
implantado na imagem de fundo.
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Atenção! Neste modo o programa trábala somente com a imagem de fundo. A imagem-objeto não se altera.

Passo 6. Clique no botão   para iniciar o processo de criação da fotomontagem. O resultado será mostrado na pasta

Depois.

Se não estiver satisfeito com o resultado, mude para a Depois, mude as cores, ajuste a Limite e clique em  de

novo.

Você também pode usar as  ferramentas de pós-processamento (Borrar , Desfocar  e Pincel histórico )

para editar o resultado.
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PARA FÂS DE PICHAÇÔES

Pichações são como uma forma de arte em seus primeiros moldes modernos do tipo aparecido no inicio do século 20, mas suas
origens vão ao passado quando os homens expressaram os seus primeiros talentos nas paredes das cavernas.

Qualquer pichação é um trabalho de arte ou mero vandalismo, esta pergunta não tem nenhuma resposta definida. Algumas
pichações têm a valor artístico e uma idéia atrás delas; outros são um desperdício de pintura e a declarar apresentável dano
a propriedade privada.

Neste tutorial nós queremos mostrar como fazer pichação em qualquer parede sem correr qualquer risco de ser multado.

A imagem abaixo foi capturada da internet. Nós não conhecemos o autor pessoalmente, mas esperamos que ele não note.

Nós usamos o plugin Chameleon no Adobe Photoshop, mas você pode usar qualquer outro editor de fotografia compatível
com o plugin AKVIS Chameleon.

  

Passo 1. Abra a imagem de pichação no seu editor de fotografia.

Passo 2. Faça uma seleção precisa do fragmento. Neste caso o desenho de pichação tem uns moldes difíceis, mas o
fundo é homogêneo. É mais fácil de apagar o fundo que selecionar o objeto.

No Adobe Photoshop voce pode usar a ferramenta Borracha mágica . Selecione a ferramenta e clique esquerdo

no fundo ao redor da galinha e entre as asas e penas. O fundo será removido.

Agora selecione o fragmento. Para rápida seleção clique no ícone de camada na paleta de Camadas mantendo a tecla
Ctrl  (⌘  no Mac) pressionada.

AKVIS Chameleon

66

https://akvis.com/pt/compatibility-software.php?utm_source=help


Paleta de Camadas

Selecione o comando Filtro -> AKVIS -> Chameleon – Grab Fragment (capturar o fragmento) no menu principal.
Você verá uma mensagem que o objeto selecionado foi salvado no clipboard.

Passo 3. Abra a imagem de fundo. Aqui nós temos uma fotografia de uma parede de tijolos.

Passo 4. Selecione o comando Filtro -> AKVIS -> Chameleon – Make Collage (fazer uma colagem).

A área de trabalho do Chameleon abre com a imagem de fundo carregada na Janela de imagem.
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Passo 5. Selecione o modo Emersão no Painel de ajustes.
Passo 6. Use a ferramenta Transformar  para ajustar o tamanho e a posição da galinha na parede.

Passo 7. Selecione as cores da parede. As cores selecionadas serão substituídas com as áreas do fragmento.

Passo 8. Clique em  para iniciar o processamento da imagem. Aqui está o resultado:
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Passo 9. Para a imagem parecer mais natural ajuste o valor do parâmetro de Limitação. Neste caso o valor ótimo é
aproximadamente 50-60.

Agora parece mais realístico.

Aplique o resultado. Clique em  para aplicar o efeito e fechar a janela do plugin. O resultado será mostrados na área

de trabalho de seu editor de fotografia.

Passo 10. Mais um truque para dar a imagem o toque final. No Passo 4 um pode ver uma sombra desaparecida após o
processo com o plugin. Nós podemos restabelece-lo usando a ferramenta  Gravar no Photoshop. Selecione esta
ferramenta e ajuste suas configurações. Agora clique esquerdo na sombra e, mantendo a tecla Shift  pressionada para

adquirir uma linha direta, desenhe uma linha em cima dos grafitos. Aqui está o resultado final:
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P. S.: Nenhuma parede foi estragada como resultado desta experiência!
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PÁSSARO NA GAIOLA

AKVIS Chameleon pode ser usado não somente para colocar um objeto em novo fundo, mas também para combinar objetos.
O modo Emersão pode trocar objetos de primeiro plano para o fundo e vice versa.

Neste tutorial mostraremos como "embutir" um pássaro em uma imagem para fazer parecer como se estivesse dentro das
barras de uma gaiola.

  

Passo 1. Abra AKVIS Chameleon e aperte  para abrir a foto de uma gaiola – ela será o fundo para a colagem.

Passo 2. Aperte  para abrir um objeto. Usamos a imagem de um pássaro com um fundo transparente.

Passo 3. Escolha o modo Emersão da lista pendente no Painel de ajustes, ai use a ferramenta Transformar 

para modificar o tamanho e a localização do pássaro no fundo.
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Passo 4. Em seguida daremos ao programa uma "sugestão" para onde o pássaro deve ser misturado ao fundo. Clique
em um dos quadrados no Painel ajustes (o cursor se torna uma pipeta) e então clique dentro da gaiola onde parte da
parede se mostra. Este quadrado exibe a cor selecionada. Pode-se escolher até seis cores especificas (no nosso caso
elas serão preto e marrom escuro).

Passo 5. Comece o processamento da imagem apertando . O resultado é mostrado na aba Depois. Vemos que a

gaiola permanece inalterada, enquanto que o pássaro aparece dentro das barras.
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Passo 6. O parámetro Limitação controla quanto de um objeto é combinado com o fundo. Aumentando seu valor torna
o pássaro dentro da gaiola mais visível. Defina este valor em 40 e reprocesse a imagem.

O resultado é mostrado na aba Depois. O pássaro se mistura com a gaiola de maneira plenamente convincente.
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Imagens de origem

O MODO DUPLA EXPOSIÇÃO

AKVIS Chameleon propõe 5 modos de criação de montagens de fotos: Montagem, Camaleão, Fusão, Emersão e Dupla
exposição.

O modo Dupla exposição é baseado na técnica usado por fotógrafos. As duas imagens são sobrepostas numa única foto
com o uso dos modos de mesclagem diferentes e levando em conta os valores de luminância. Os pixels de fundo mais escuros
são substituídos por os pixels mais claros de um fragmento, e os pixels mais escuros de um fragmento são substituídos por os
pixels de fundo mais claros.

O mais popular é combinar as cenas de paisagens com os retratos humanos em que uma silhueta escurece uma foto de
sobreposição ou aparece isolada numa fundo em branco com uma imagem de superposição mostrando através dela.

Atenção! Este modo está disponível apenas para as licenças Home Deluxe e Business.

Resultado

 

Siga as instruções para criar um efeito de dupla exposição usando AKVIS Chameleon:

Passo 1. Clique em  para abrir uma imagem para o fundo, depois clique em  para abrir uma imagem com um

fragmento para uma colagem.

Atenção: Se você usa o plugin, por favor faça o seguinte.

Passo 2. Use a ferramenta Transformar  para alterar o tamanho, o ângulo e a posição do objeto acima da imagem

de fundo.

Use o parâmetro Opacidade para colocar o fragmento com mais precisão.

AKVIS Chameleon

74

https://akvis.com/pt/chameleon/comparison.php?utm_source=help


Passo 3. Use as ferramentas de seleção para selecionar um fragmento para uma exposição dupla e marcar as áreas
indesejadas.

Passo 4. Ajuste o parâmetro Intensidade, que regula a intensidade de uma máscara de luminância. Em valores de
parâmetros pequenos, o resultado é mais claro. Quanto maior é o valor, a imagem é mais brilhante e mais contrastada.
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Intensidade = 10 Intensidade = 100

Passo 5. Pressione  para iniciar o processo de criação da colagem. O resultado será mostrado na aba Depois.

Você também pode usar as  ferramentas de pós-processamento (Borrar , Desfocar  e Pincel histórico )

para editar o resultado.

 

AKVIS Chameleon

76



EFEITO DE EXPOSIÇÃO DUPLO: GALERIA DE IMAGENS

Dê uma olhada na galeria de imagens criado em AKVIS Chameleon. Se você gostaria de enviar as suas imagens para
publicação, por favor entre em contato conosco!

 

Aqui estão alguns trabalhos inspiradores criados por Jens e Rachel Christinger:

Atmosfera de cidade grande
(clique para ampliar)
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Nações dançantes
(clique para ampliar)

O homem árvore
(clique para ampliar)

AKVIS Chameleon

78

http://akvis.com/img/examples/chameleon/examples/chameleon/double-exposure-gallery/dance-r.jpg
http://akvis.com/img/examples/chameleon/examples/chameleon/double-exposure-gallery/tree-man-r.jpg


Eternidade
(clique para ampliar)

Sonho
(clique para ampliar)
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Vida urbana
(clique para ampliar)

Eternidade II
(clique para ampliar)
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O corvo da floresta
(clique para ampliar)

 

Aqui estão outros exemplos criados com o uso de AKVIS Chameleon:

A caminhada solitária
(clique para ampliar)

AKVIS Chameleon

81

http://akvis.com/img/examples/chameleon/examples/chameleon/double-exposure-gallery/crow-r.jpg
http://akvis.com/img/examples/chameleon/examples/chameleon/double-exposure-gallery/forest-r.jpg


A senhora da flor 
(clique para ampliar)

O beijo
(clique para ampliar)
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O amor interestelar
(clique para ampliar)

A raposa
(clique para ampliar)
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O pôr do sol no telhado
(clique para ampliar)

Fumar
(clique para ampliar)
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O sonho de Provença
(clique para ampliar)

Os alpinistas
(clique para ampliar)
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A raiva cega
(clique para ampliar)

A hora de relaxar
(clique para ampliar)
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O conquistador do Espaço
(clique para ampliar) 
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CORVO DA FLORESTA: EFEITO DA DUPLA EXPOSIÇÃO

Este exemplo mostra como combinar as duas imagens numa colagem fantástica usando AKVIS Chameleon.

Passo 1. Clique no botão   e selecione uma foto de fundo.

Passo 2. Em seguida, clique no botão   e selecione uma foto com um objeto que você deseja adicionar ao plano de

fundo.
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Passo 3. Selecione o modo Dupla exposição.

Use a ferramenta Transformar  para ajustar o tamanho e a posição do objeto inserido. Defina a Opacidade como

50% para posicionar o fragmento com mais precisão.

Passo 4. Inicie o processamento da imagem clicando no botão  .
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Passo 5. Selecione a ferramenta Pincel histórico  da barra de ferramentas e processe a colagem. Com os

diferentes modos de pincel, você pode restaurar as partes do plano de fundo, a imagem de fragmento ou o resultado de
processamento automático.

Você também pode converter a colagem resultante em escala de cinza ativando a caixa de verificação Preto e branco.
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OS PROGRAMAS DE AKVIS

 

AKVIS AirBrush — Técnica de aerografia em suas fotos

AKVIS AirBrush permite imitar a técnica artística de aerografia. O software transforma automaticamente uma fotografia em
sua própria obra-prima de arte de alta qualidade, que parece ter sido criada com uma ferramenta de aerógrafo especial.
Mais…

 

AKVIS Artifact Remover AI — Restauração de imagens comprimidas em JPEG

AKVIS Artifact Remover AI usa algoritmos de inteligência artificial para remover artefatos de compactação JPEG e restaurar
a qualidade original das imagens compactadas. O programa está disponível gratuitamente. Será muito útil para usuários
domésticos e profissionais. Mais…

 

AKVIS ArtSuite — Efeitos e molduras para fotos

AKVIS ArtSuite é uma coleção de efeitos de molduras para decoração das fotos. Uma moldura bem escolhida completa a foto
e põe-a em valor. O software oferece uma grande variedade de molduras para fotos. O software propõe uma biblioteca de
amostras para criar molduras, nos quais se encontram flores, tecidos, penas, etc. Mais…

AKVIS Chameleon

92

https://akvis.com/pt/airbrush/index.php?utm_source=help
https://akvis.com/pt/airbrush/index.php?utm_source=help
https://akvis.com/pt/airbrush/index.php?utm_source=help
https://akvis.com/pt/artifact-remover/index.php?utm_source=help
https://akvis.com/pt/artifact-remover/index.php?utm_source=help
https://akvis.com/pt/artifact-remover/index.php?utm_source=help
https://akvis.com/pt/artsuite/index.php?utm_source=help
https://akvis.com/pt/artsuite/index.php?utm_source=help


 

AKVIS ArtWork — Coleção de técnicas de pintura e desenho

AKVIS ArtWork é destinado a imitar diferentes técnicas de pinturas. O programa ajuda a criar uma peça de arte de qualquer
foto. O programa propõe estos efeitos: Óleo, Aguarela, Guache, Cômico, Caneta e tinta, Linogravura, Pastel e Pontilhismo.
Crie um retrato a óleo de seu amigo, uma paisagem pintada ou uma natureza morta! Mais…

 

AKVIS Chameleon — Colagens e montagens de fotos

AKVIS Chameleon é uma solução ideal para criação de colagens e montagens de fotos. 
O software é extremamente fácil de usar. Com o programa você não precisa fazer um trabalho penoso, voce pode concentrar-
se na parte criadora! Mais…
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AKVIS Charcoal — Desenhos a carvão e giz

AKVIS Сharcoal é uma ferramenta artística para conversão de fotos com desenhos a carvão e giz. Usando o programa você
pode criar desenhos em preto e branco expressivos com aparência profissional. Ao jogar com as cores e opções pode
conseguir efeitos artísticos independentes como sanguínea e outros. Mais…

 

AKVIS Coloriage — Coloração de fotos em preto e branco

AKVIS Coloriage é um programa para manipulação com cores da imagem: coloração das fotos em preto e branco, mudação
os cores de fotografias coloridas. Basta fazer somente alguns traços de lápis. O programa identifica as limites do objecto,
cobre o objecto com as cores indicadas levando em conta a iluminação, sombras do objecto original. Mais…

 

AKVIS Decorator — Alterando texturas e cores

AKVIS Decorator permite aplicar novas texturas ou cores em um objeto de maneira realista. As alterações podem ser feitas
em partes de uma imagem, possibilitando adicionar aos objetos e roupas das fotos uma enorme variedade de texturas, como
veludo, cetim, madeira ou até doces. Mais…
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AKVIS Draw — Efeito de desenho a lápis

AKVIS Draw permite criar esboços a lápis desenhados a mão de suas fotos digitais. O software produz criativamente traços a
lápis imitando uma exibição de artista. Dê um visual de desenho manual às suas imagens! Mais…

 

AKVIS Enhancer — Reforço dos detalhes

AKVIS Enhancer é útil nos casos quando à foto lhe falta detalhe ou a foto tem uma exposição irregular (partes
sobreexpuestas e subexpuestas), o programa melhora o nível de detalhe, contraste e nitidez da imagem.  Enhancer pode
melhorar as texturas, revelar os detalhes das áreas de sombras e veladas. O programa trabalha em três modos: Realçar
detalhes, Pré-impressão e Correção de tons. Mais…

 

AKVIS Explosion — Efeitos fabulosos de explosão e destruição

AKVIS Explosion oferece efeitos de explosão de partículas para as fotos. O programa destrói um objeto e aplica partículas
de poeira e areia a uma imagem. Com este software você pode criar imagens atraentes em apenas alguns minutos! Mais…
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AKVIS Frames — Decore suas fotos com molduras

AKVIS Frames é software gratuito de edição de fotos, projetado para usar os pacotes de molduras de AKVIS

 

AKVIS HDRFactory — Imagens HDR: Mais brilhante do que a realidade!

AKVIS HDRFactory é um programa versátil para criar Imagem de Alta Faixa Dinâmica e fazer correções de fotos. O programa
pode também imitar o efeito HDR em uma única imagem, criando um pseudo-HDR. O software trás vida e cor para suas fotos!
Mais…

 

AKVIS LightShop — Efeitos de luz e estrelas

AKVIS LightShop ajuda você a criar surpreendentes efeitos de luz: chamas flamejantes no Sol; as luzes de planetas
distantes... – onde sua imaginação puder levar você. Efeitos de luz podem realçar qualquer imagem. Adicione um pouco de
mágica para suas fotos! Mais…
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AKVIS Magnifier AI — Redimensione imagens sem perda de qualidade

AKVIS Magnifier AI permite redimensionar imagens automaticamente e rapidamente sem perda de qualidade. Usando
algoritmos baseados em redes neurais, Magnifier AI amplia imagens digitais a alta resolução para a produção de impressões
grandes. Mais…

 

AKVIS MakeUp — Retocar as suas fotos!

AKVIS MakeUp melhora retratos e adiciona glamour às fotos, dando-lhes um aspecto profissional. O programa suaviza
automaticamente pequenos defeitos da pele, tornando-a brilhante, bela, pura e suave. Mais…

 

AKVIS NatureArt — Efeitos naturais em fotos digitais

AKVIS NatureArt é uma excelente ferramenta para imitar a beleza dos fenômenos naturais em suas fotos digitais.  O
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programa inclui vários efeitos: Chuva

 

AKVIS Neon — Pinturas brilhantes a partir de fotos

AKVIS Neon permite criar efeitos impressionantes com linhas brilhantes de luz. O software transforma uma foto em um
desenho de néon que parece feito com tinta luminescente. Mais…

 

AKVIS Noise Buster AI — Redução de ruído digital

AKVIS Noise Buster AI é um programa para supressão de ruídos em imagens digitais e scaneadas. O software reduz os tipos
diferentes de ruído (de iluminação e de cor) sem estragar os outros aspectos da fotografia. O software inclui tecnologias de
inteligência artificial e ajustes para refino manual. Mais…
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AKVIS OilPaint — Efeito de pintura a óleo

AKVIS OilPaint transforma suas fotos em pinturas a óleo. A misteriosa produção de uma pintura acontece bem diante dos
seus olhos. O algoritmo original reproduz autenticamente verdadeira técnica do pincel. Com este programa de última geração,
você pode se tornar um pintor! Mais…

 

AKVIS Pastel — Pintura a pastel de uma foto

AKVIS Pastel transforma fotos em pinturas a pastel. O programa converte sua foto em uma arte digital, imitando uma das
técnicas artísticas mais populares. AKVIS Pastel é uma ferramenta poderosa para libertar a sua criatividade! Mais…

 

AKVIS Points — Efeito de pontilhismo para suas fotos

AKVIS Points permite transformar suas fotos em pinturas usando uma das técnicas artísticas mais emocionantes -
pontilhismo. Com o software você pode facilmente criar obras de arte de uma maneira pontilhista. Entre no mundo de cores
brilhantes! Mais…
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AKVIS Refocus AI — Efeitos de nitidez e desfoque

AKVIS Refocus AI melhora a nitidez de fotos desfocadas. O programa pode processar a foto inteira ou pode trazer para o
foco somente a parte selecionada de forma a destacar o assunto no fundo de cena. Também é possível adicionar efeitos de
desfoque nas suas fotos. O software funciona em três modos: Foco AI, Miniatura e Desfoque da íris. Mais…

 

AKVIS Retoucher — Restauração de imagens

AKVIS Retoucher é uma programa para restauração das fotos antigas e danificadas. Permite tirar pó, arranhões, objectos
irrelevantes, textos indesejáveis, datas de uma imagem. Funciona com imagens em preto e branco e com imagens em cores.
Mais…

 

AKVIS Sketch — Converta fotos em desenhos a lápis
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AKVIS Sketch é um programa para converter fotos em desenhos surpreendentes. O software cria obras de arte em cores
realistas e esboços em preto e branco, imitando a técnica de grafite ou lápis de cor. O programa oferece los estilos de
conversão seguintes: Clássico, Artístico e Maestro. Cada estilo tem uma série de predefinições. AKVIS Sketch permite que
você se sinta um verdadeiro artista! Mais…

 

AKVIS SmartMask — Ganhe tempo em seleções complexas

AKVIS SmartMask é uma ferramenta de seleção que poupa seu tempo e é divertida para usar. Nunca antes houve uma
seleção tão simples! O software permite selecionar objetos de imagens e remover fundos. Mais…

 

AKVIS Watercolor — Pintura aquarela de foto

AKVIS Watercolor faz facilmente a foto parecer com a pintura da aquarela brilhante e emocionante. O software transforma
imagens comuns nas obras de arte de aquarela incrivelmente realísticas. Mais…
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